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Title of unit or other component  

 

Mandatory/ 

Optional 

Estimated 

size 

(learning 

hours) 

Understanding Computer fundamental and office 

automation software 
Mandatory 

50 

Introduction To Financial Accounting  Mandatory 50 

Preparation of Account Books Using Accounting 

Packages 

Mandatory 50 

Working with Desktop Publishing Softwares Mandatory 50 
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Detailed Curriculum 

 

Name of Unit of 

Qualification 

: 

 

Understanding Computer fundamental and office 
automation software 

Duration : 50 Hours 

Topics : Computer Fundamental, Operating System, Office 
Automation  

 

Performance 

Criteria(OUTCOME) 

No. 

Contents Hrs. 

OUTCOME-1: 
Acquiring Skills to 
Understand  
Computer 
Fundamental 

Generation of computers, types of computers, 

micro, mini, main frame & super computers, 

applications, functional units & operation concepts.  

Memory Structure 
Basic concepts, types of memories from 

semiconductor RAMs, Memory system 

Considerations, ROMs, concepts of cache and 

virtual memory.  

Processor Unit 
Basic concepts, sequence of operations to execute a 

complete instruction, hardware control and micro 

programmed control-brief introduction.  

Secondary Storage 
Magnetic disk systems-floppy and hard disk -

concept of disk operations-characteristics of 

different types of disk systems-magnetic tape 

systems-concept of optical storage devices.  

I/O Devices 
Various I/O devices-concept of video terminals-

video displays-alphanumeric displays-graphic 

displays.  

Printers & Plotters 

Types-Specifications-Characteristics.  

 

05 

OUTCOME-2: 
Understanding 
Operating System and 
its functions 

Operating System: 
DOS  
Introduction, Different Operating Systems, Loading 

and Quitting the Operating Systems, Important 

DOS Commands (Internal and External), File and 

Directory System Concepts in DOS.  

WINDOWS 
Introduction Operating System  

Desktop icons  

My Computer, Recycle Bin, Internet Explorer, 

Network Neighbourhood, My Documents.  

Working with windows  

How to create a Folder, Copying and cutting files, 

Renaming.  

Start icon  

05 
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Programs, Favorites, Documents, Settings, Find, 

Run, Shut down, application icons  

 

OUTCOME-3: 
Acquiring Skills to use 
Office Automation 
Software 

An introduction to word 
The Word workspace, Starting and quitting Word, 

Creating and Manipulating Various documents, 

Editing of proofing files, Merging documents and 

macros.  

How to use mouse and menu 
Working with dialog box.  

Primary commands in file menu 
The open command, The New command, The Save 

As and Save all commands, The Close command, 

The Page Setup, The Print Exit command.  

Edit menu commands 
The Cut, Copy and Paste commands, The Undo and 

Repeat commands.  

Format commands Font commands, Paragraph 

command.  

Other menu 
The View menu, The Inset menu, The Tools menu, 

The Table menu, The Window menu.  

Spread Sheet Preparation Using MS Office  

Building a simple worksheet 
Entering Text, Entering Values, Entering Dates and 

Times, Moving Around, Selecting Ranges, Using 

Menu, Using Tool Bar, Using Shortcut Menus, 

Changing entries, Copying entries, Moving Entries, 

Inserting and Deleting cells.  

Formatting Basics 
Changing Character Style, Changing Alignment, 

Changing Column Width.  

Working with Multiple worksheet 
Copying entries between work books, Moving 

sheets between work books, Deleting sheets, 

Quitting Excel.  

Opening existing workbooks 
Simple calculations. Doing Arithmetic, Totaling 

column of values, Naming cells and Ranges.  

Formatting Text 
Displaying dollars and cents, Formatting decimal 

places, Formatting dates, Copying style and 

formats. Formulas that make decisions — Using the 

IF function, Using the nested IF function, Copying 

formulas. Checking Spelling, Printing Worksheets, 

Preview Worksheets, Setting up the pages. Sorting 

data, Keeping Leading in View, Finding records, 

Adding and deleting Records, Filtering Records. 

Plotting charts, Sizing and moving charts, Updating 

charts, Changing the chart type, Using chart auto 

format. Creating Macros, Recording Macros, 

40 
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Running Macros.  

Database Concepts Using MS Access  

Introduction to Database 

Database System Concepts, DBMS and RDBMS  

Planning and designing a database  

Creating a database — Sorting Data in Tables, 

Fields, Records, Two ways to Create a Database, 

Creating a Database with Database Wizard  

Building and Modifying Tables  

Create Tables by using the Table Wizard, Create 

Tables from Scratch, Field Names Data Types and 

Filed Properties, Modify Tables Using Design 

View, Entering Data in a Data sheet, Editing Data 

in a Datasheet, Changing the Width of Columns and 

Height of Rows, Changing the Order of Columns, 

Setting of Primary Key  

Defining Relationship 
Establish Relationship, Enforce Referential 

Integrity  

Querying a Database 

Constructing a Query, Creating the Query, Choose 

the Tables to Query, Field to Query, Entering the 

Query criteria, Saving the Results of a Query  

Different Kinds of Queries 
Crosstab, Update, Delete, Append, Make Table  

Building and Modifying Forms 
For Entering and Viewing Data, Creating a Form 

(Design View of Form Wizard), Use the Control 

Toolbox to Add Controls, Modify Format 

Properties (Font Style, Size, Color, Caption, etc.) of 

Controls, Use of Form Sections (Header, Footers 

and Detail), Use of Calculated Control on a Form.  

Slide Presentation Using MS Office  

Power Point  

Main Features of Power Point, Making the 

Presentation, Creating Template with the Auto 

Content Wizard. Creating a Presentation with a 

Template. Creating a presentation from Scratch 

Different Views 
Normal Slide, Outline, Slide Sorter, Slide Show, 

Notes, Slide Master Animation ,ART and Sound 

Controlling Transitions between slides. Animating 

Different Parts of a slide. Inserting a Motion Clip. 

Including Sounds in slides. Including Graphs, 

Charts, Tables and Columns Organization Chart 

Slide, Creating a table Slide. Creating two column 

Slide, Module 1: Showing A Presentation, 

Rehearsing/ Timing a Presentation, Designating 

some slides as ―Hidden, Viewing Slides 

Anywhere in a Slide Show. Techniques for Making 

a Show Livelier Office Connections Presenting 
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with the help of other Office Programs Importing 

the text from a Word Document.— Printing a 

Presentation.  
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Name of Unit of 

Qualification 

: 

 

Introduction To Financial Accounting  

Duration : 50 Hours 

Topics : Financial Accounting 

 

Performance 

Criteria(OUTCOME) 

No. 

Contents Hrs. 

OUTCOME-1: 
Core Skills to Prepare 
Financial Accounting 

Introduction to Accounting 

What is Accounting, Financial Accounting Books 

of Accounts, Cash, Journal, General Ledger 

Classification of Accounts and Rules of Debits 

and Credit, Financial Statement,  Trial Balance, 

Final Accounts Statements, O / S Bills Tracking  

Inventory Management 
Inventory Analysis, Depreciation, Delivering In 

& Out, Purchase & Sales Invoice, Debit & Credit 

Notes Foundation of Accounts, Ledger Accounts 

and Groups, Account Groups, Liability Side, 

Assets Side, Income Side, Expense Side  

 

20 

OUTCOME-2: 
Advance Skills to 
Prepare Financial 
Accounting 

Capital Account 

Capital, Reserves & Surplus (Retained Earnings) 

Loans (Liabilities), Bank overdraft, Secured 

Loans & Unsecured Loans Current Liabilities, 

Duties & Taxes, Provisions, Sundry Creditors, 

Current Liabilities  

Fixed Assets 

Investments Current Assets, Stock in Hand, 

Deposits (Assets), Loans & Advances (Assets), 

Sundry Debtors, Cash in hand, Bank Account 

Miscellaneous Expense & Suspense Account, 

Sales & Purchases, Direct & Indirect Income, 

Direct & Indirect Expenses  

Inventories 

Introduction Types of inventory, Inventory in 

case of manufacturing, Raw materials, Work-in-

progress, Finished goods / stock, Inventory in 

case of trading concern, Finished goods / stock 

Basis of inventory valuation, Cost, Net realizable 

value Techniques of Inventory valuation, 

Historical cost methods, FIFO, LIFO, Average 

Price, Weighted average price, Non-Historical 

cost methods Inventory Record system, Periodic 

Inventory system, Perpetual inventory system  

. 

30 
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Name of Unit of 

Qualification 

:Preparation of Account Books UsingAccounting 

Packages 

Duration :  50 Hours 

Topics : Prepare Account Books Through Accounting 

Package(Tally) 

 

Performance 

Criteria(OUTCO

ME) No. 

Contents Hrs. 

OUTCOME-1: 

Acquiring The Skills 

To Prepare Account 

Books Through 

Accounting Package  

Tally  

Introduction to Tally, Tally Fundamentals, 

Features of Tally, Tally start up screen and 

components, Tally clock, Switching between 

screen area- Ctrl-n & Ctrl-m, Quitting Tally. 

 Maintaining Company Data 
Basic Company Details, Creation, Modification, 

Tally – Accounting & Inventory, Chart of 

accounts – Group , Ledger, Introduction to F11- 

Features, Introduction to F12- Configurations, 

Maintaining stock details, Inventory Masters, 

Displaying and altering stock group, Creating 

and altering multiple stock categories, Creating 

and altering unit of measure. 

Tally Vouchers 
Accounting Vouchers, Contra Voucher (F4), 

Payment Voucher (F5), Receipt Voucher (F6), 

Journal Voucher (F7), Sales Voucher (F8), 

Credit note Voucher (Ctrl+F8), Purchase 

Voucher (F9), Debit note Voucher (Ctrl +F9), 

Reversing Journal (F10), Memo Voucher 

(Ctrl+F10), Optimal Voucher,Postdated 

Voucher, Inventory Vouchers, Inventory 

Vouchers, Purchase order, Sales order, Rejection 

out, Rejection In, Stock journal, Delivery Note, 

Receipt Note, Physical note, Invoicing. 

 

30 

OUTCOME-2:  

Acquiring The Skills 

To Prepare Account 

Books Through 

Accounting Package 

Display and Reporting 
Financial report, Financial Statutory Report, 

Balance sheet, Profit & Loss A/C, Trial Balance, 

Sales Register, Purchase Register, Journal 

Register, Cash Book, Bank Book and Ledger, 

Financial MIS Report, Group Summary, Group 

Vouchers, Statement of Accounts, Cost 

center,out standings , Interest calculations 

,statistics, Inventory Report, Inventory Statutory 

Report, Inventory MIS Report. 

20 
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Technology Advantages of Tally, Tally Vault, 

Security control, Tally Audit, Backup and 

Restore, Split company data, Export and Import 

of data, ODBC Compliance Printing, New 

features in Tally 9, Value Added Tax (VAT), 

Tax Deduction at Source (TDS), Service Tax, 

Pay Roll Accounting. 
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Name of Unit of 

Qualification 

: Working with Desktop Publishing Softwares 

Duration : 50 Hours 

Topics :Page Maker, Photo Shop and Coral Draw 

 

Performance 

Criteria(OUTCOME) 

No. 

Contents Hrs. 

OUTCOME-1: 

Acquiring Skills on  

Page Maker 

Page Maker 
Introduction to Desktop Publishing, Introduction 

to PageMaker Advantages, Using the Mouse, 

Components of the PageMaker Window. Setting 

the Margins, Setting the Page Size, Changing the 

page Orientation, Setting Page Numbers, 

Changing the Page Size view, Creating New 

Document Windows: Displaying the Rulers, 

Changing the Rulers, Using Rulers, Using 

Guidelines, Positioning Guidelines, Adding 

Guidelines to Master Pages. Aligning to 

Guidelines, Displaying Guidelines, Locking 

Guidelines. Formatting Types: Changing Fort 

Families, Changing Font Sizes, Changing 

Typeface Style, Changing Character 

Specification: Changing Type leading, Changing 

Character Widths, Changing Tracking, Changing 

Type Options. Saving Your Document: Saving a 

new Documents, Saving an existing Document, 

Saving a Document as another document, 

Reverting to a Previously Saved Version. 

Developing Paragraphs: Typing Text, Adding 

special Characters to Text, Aligning Text. 

Formatting Paragraphs: Changing Indents, 

Changing the space around Paragraphs, 

Changing Paragraph Alignment, Controlling 

How Paragraphs Break Between Pages and 

Columns, Adding lines Above or Below Your 

Paragraphs. Converting Other Objects to 

Frames, Threading and Unthreading Text. 

Threading additional Text, Threading Text to 

Different Page. Unthreading Text Blocks, 

Rethreading Text Blocks, Making Text Blocks 

Disappear Without Deleting them, Selecting and 

Dragging Text, Editing Deleting Text, Cut, 

Copying, Pasting Text, Viewing the Contents of 

Clipboard, Using Undo and Revert. Inserting 

and Removing Pages: Inserting and Removing 

Pages, Adjusting Spacing of Characters, Words, 

Lines: Adjusting, Spacing and Leading, Setting 

20 
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and changing Tabs. Introduction to Auto Flow, 

PageMaker Plug-Ins, Drop Cap, Change Case, 

Bullets and Numbering. Adding Design 

Elements – Introduction Adding Graphics to 

your Documents, Adding Lines, Changing Lines 

Specifications, Adding Shapes, Changing Shape 

Specifications, Changing Line and fill, 

Specifications together (fill and Stroke), 

Changing Round Corners, Creating Drop-

Shadow, Boxes, Text wrap, Changing 

PageMaker Options: Adjusting Margins, Setting 

and Adjusting Columns, Setting Unequal Width 

Columns, Creating headers and Footers, 

Creating Graphics in PageMaker, Rotating Text, 

Skewing and Mirroring objects with Control 

Palette. Importing Graphics into PageMaker: 

Placing, aligning Graphics, Cropping Graphics. 

Setting up Templates Setting Up Master Page 

Templates, Creating Custom Page Sizes, 

Creating Custom Borders, Creating a News 

Paper Template, Creating New master Pages, 

Saving an existing Page As a Master Page. 

Setting UP Custom Styles: Defining Styles, 

Creating, Editing, Removing Styles and Copying 

Styles. Introduction to Using layers, n-Layers 

Palette, Moving and creating objects. 

Introduction to Printing – Selecting a Printer 

Printing your Document, Printing Document 

Dialog Box Options. Adding Color Introduction 

– Using PageMaker Default Color Palette, 

Opening Color Palette, Adding color to Text, 

Working with Color Graphics, Defining Custom 

Colors, Creating Text Screens. Developing Long 

Documents Introduction – Using Story Editor: 

Opening Story Editor, How the Story Editor 

names, Tories, Switching Between Story Editor 

and Layout Editors, Closing Story Editor and 

Placing the Story Editor, Differences between 

Story Editor and layout Editors. Spellings 

Starting the speller, Correcting Misspelled 

Words, Correcting Duplicate Words, Adding 

Words to the different Dictionaries, Correcting 

Duplicate Words, using find Feature, Using the 

change Feature, Creating an Index, using 

PageMaker Help.  

OUTCOME-2: 

Acquiring Skills on 

Photo Shop and Coral 

Draw 

PHOTOSHOP  

Elements of Photoshop, The Elements 

Environment, Exploring the Photoshop Elements 

Work Area, Basic Tools and Palettes Modifying 

an Image, Making Minor Adjustments to your 

Image, Adjusting the Lighting in Your Image 

30 
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Enhancing an Image, Enhancing an Image with 

Text, Enhancing an Image with the Painting 

Tools, Enhancing an Image with Layer Effects, 

Enhancing an Image with Filters Composite 

Images, Creating a Composite Image, Create an 

Animated GIF, Creating Composite Images 

using Photo merge The Finished Product, Saving 

Images for the Web and Creating a Web Gallery, 

Photoshop Elements Print Options  

CORELDRAW 
Basics of CorelDraw Introduction, Getting 

Started, Creating A New File, Title Bar, Work 

Area, Printable Page, Property Bar, Page 

Counter Bar,Color Palette, Toolbox, Statues Bar, 

Drawing Figures, Lines, Ellipse, Circles, 

Rectangle, Square, Polygon, Saving, Closing, 

Opening, Views, Normal View, Preview, Wire 

Frame View, Draft View, Zoom View Manager, 

Creating View Drawing Introduction, Toolbox, 

Selecting an Object, Resizing an Object, 

Moving, Moving An Object, Changing the 

Shape, Combining Two Objects, Skewing, 

Welding the Objects, Blending, Curve Lines, 

Straight Lines Continuing a Line,View Mode, 

Changing, Media Tool Rotating An Object, 

Grouping-Fill Tool Fly OutFilling, Spray Mode. 

Text Introduction, Text Tool, Entering Artistic 

Text, Entering Paragraph Text, Converting Text, 

Formatting Text, Changing the Font Size, 

Arranging Objects, Ordering the objects, 

Changing the Font, Bullets, Decorating the Text, 

Welding, Text Editor, Opening, Changing the 

Alignment, Type Style, Spell Checking, 

Grammar Searching Synonyms, Find, Replace, 

Editing, Kerning, Formatting Characters.  

Images Bitmap Images, Vector Images, 

Resizing, Rotating, Skewing, Moving, Cropping, 

Importing Images, Adding Special Effects, 

Converting to Bitmap, Exporting Images. Page 

Layout Changing the Page Size, Changing the 

Layout, Applying Styles, Applying Bitmaps to 

the Background, Changing the Background, 

Adding a Page Frame, Moving Between Pages.    

 

 

 


